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Introduction to DoubleZIP
 
What DoubleZIP can do for you!
 
Removable disk drives provide you with direct-access backup capability and a method of easily 
transferring large files (or a large number of files) between computers.    You can use DoubleZIP to do the 
backup, update and transfer of your files to your Removable disks.    DoubleZIP, provides you with a quick 
way to keep your removable disks synchronized with your hard disks on your PC.    Thats not all.    
DoubleZIP also can save you money by increasing (doubling in some cases) the amount of data that you 
can store on each removable disk!        Click here for a list of its major features. 
 
Corporate Background
 
Kiss Software Corporation is a world-wide publisher of a variety of software products, including utilities 
and diagnostic software.    Kiss Software is proud of its motto, Powerful Software Made Simple.

Kiss Software’s association with LinkPro, Inc., brings to the user DoubleZIP    LinkPro is an innovative 
leader in distributed data management products with special renown for its automatic file synchronization 
technology.

Both Kiss Software and LinkPro maintain their corporate headquarters in Newport Beach, California.

 Customer License Agreement
 
The complete Customer License Agreement is printed at the beginning of the User Guide.        As a 
reminder we want to point out: if you install DoubleZIP on another users PC, you must delete it after the 
transfer operation is complete, or purchase additional licenses of DoubleZIP for each user.
 



List of Major Features

·    You can transfer your Files between PCs.
        Take your data with you to the office, field or mountain cabin.

·    You can Update (Match) Files between your PC and your removable disk.
        It is easy to keep your PC and removable disk files are up-to-date.

·    You can back-up your data to your removable disk. 
        Selectively back-up your documents, data and digital images easily.

·    You can nearly double (on average) the data stored on each of your 
        Removable Zip disks.      Storing more data per disk can save you money.
  



Before you start DoubleZIP
 
System Requirements
For the Windows 3.1 & 3.11 version you need:
For Windows 95 & NT version (version 3.51 or higher) you need:

Installed Program Contents

Once you install DoubleZIP, you will see five icons in the DoubleZIP program group.

DoubleZIP 

Compress/UnCompress program.

Readme 

On-line Registration 

Setting your PCs Time and Date

Since DoubleZIP is a file synchronization program, the accuracy of the system clock is very 
important.    DoubleZIP will be verifying and comparing the time and date of your files as set by your 
internal computer system clock.    Make sure your system clocks on all of the PCs that you are using 
are set accurately and to the same time and date.
 
Synchronizing files with Windows 95 Long File Names

If you are synchronizing files with long file names, then you must use DoubleZIP for Windows95.    
However, if all files being synchronized have the DOS standard 8.3 file format, then they can be 
synchronized using either DoubleZIP for Windows 3.1 or DoubleZIP for Windows95.

This also means that files with long file names that have been compressed and stored on a removable 
disk using DoubleZIP for Windows95 can not be synchronized by DoubleZIP for Windows 3.1.    You must 
use DoubleZIP for Windows95 to synchronize these files.

It is recommended that you use DOS’s standard 8.3 file format on all of your PCs so long as you are 
using a mix of PCs running Windows 3.1 and Windows95.    This is because the long file name 
information is not recognized by standard 8.3 file systems, and during normal file operations the long file 
names may be destroyed.    When all of your PCs are running Windows95 or NT, then long file names can 
be used. 
 



Windows 3.1 System Requirements

·    80386 or greater IBM compatible computer with at least 4MB of RAM and 2 MB available hard disk 
space.
 
·    DOS 5.0 or higher with Windows 3.1 or 3.11 running in enhanced mode.

·    One 3 1/2 inch, 1.44 MB floppy disk drive, VGA monitor or better.



Windows 95/NT System Requirements

·    80486 or greater IBM compatible computer with at least 8MB of RAM (16MB for NT 3.51 & 4.0) and 2 
MB available hard disk space.
  
·    Windows 95, NT 3.51 or NT 4.0

·    One 3 1/2 inch, 1.44 MB floppy disk drive, VGA monitor or better.



DoubleZIP Icon

Clicking on this icon will start the DoubleZIP program.



Compress/UnCompress Program

Clicking on this icon will start the Compress/UnCompress program.    This program allows you to 
compress or uncompress your disk files.



ReadMe Icon

Clicking on this icon will present you with the Readme text.    This file contains    release notes for this 
version of DoubleZIP, along with descriptions of the late additions or changes to the product.    You should 
read this file before using this version of the DoubleZIP program.



On-Line Registration
  
Clicking on this icon will allow you to quickly register your product on-line.    This qualifies you for standard 
technical support.



Upgrade

Click here to receive upgrade information.



Quick Start
 
DoubleZIP is easy to get up and running quickly.    This section provides a series of quick steps for 
installation and use.    Just follow these easy steps. 
 
Since DoubleZIP does replace and delete data in the synchronization process it is important that you try 
synchronizing with non-critical files at first.
 
1      Install

Insert the first program disk into your floppy drive and perform the steps as described in Chapter 2 of 
your User Guide.
 
When the installation is completed, the DoubleZIP icon will appear in a selected program group 
window.    To open DoubleZIP, double click on the DoubleZIP icon.

 
2      Set system time and date.

Synchronization uses the time and dates derived from the system clock.    Make sure that all system 
clocks are accurate and set to the same date and time.    Use the PC procedures for setting the 
clock using the Windows Control Panel.

 3      Load Removable Disk
If you have not already done so, load the removable disk in its drive.    Make sure all files to be 
synchronized are closed before proceeding.

4      Start up DoubleZIP and Select the Disk drives
Start DoubleZIP and select the disk drives that contain the files you want to synchronize.
A. DoubleZIP will display all available drives, including removable drives that are connected. 
B. Click on the down arrow in the Drive Selection Box, select the drive and click    OK.

Click here    If you are Synchronizing your files

Click here    If you are Backing-up your files



Using DoubleZIP to Synchronize Files
 
DoubleZIP is designed to get you up and running quickly.    You simply place the Removable disk in its 
drive and run DoubleZIP by clicking on its Icon.    The Drive Selection screen appears showing you which 
disk drives are going to be synchronized. DoubleZIP then goes to the Directory Selection Screen where 
you can select two Directories    to be synchronized.    You can now setup the directory settings.    The 
program next automatically analyzes the selected directories and displays the synchronization that will 
take place in an Analyze screen.    With the click of the Sync button, your Removable disk and your hard 
disk will be synchronized.

For detailed descriptions of the steps that DoubleZIP takes you through, select from the topics below.

Drive Selection 

Directory Selection

Setup Directory Settings 

See the differences before syncing

Compressing your files to save space

Progress during sync

Sync Complete

Setting Up and Saving AutoSyncs

Selecting and Running AutoSyncs



Drive Selection
 
When you click on the DoubleZIP icon the Drive Selection screen will appear.
 
DoubleZIP will attempt to display the same drive selections made the last time you used DoubleZIP.    If 
this is not possible DoubleZIP will display the first available drive in both Drive Selection Boxes.    If the 
drives displayed in the Drive Selection Box are not the drives you want to access for synchronization, 
select the desired drives.
 
DoubleZIP will display all available drives.    To display the available drives click on the down arrow in the 
Drive Selection Box. Click on the drive you wish to select for synchronization in each Drive Selection Box.

 
Click OK when you have made your selection.    This will bring up the Directory Selection screen.

If AutoSync files are present on the hard disk, the AutoSync button is active.    If you click this button, you 
can select the desired AutoSync from a list. 

 



Directory Selection
 
You can now select two directories (one in each directory window) before synchronizing.    All files to be 
synchronized should be closed before proceeding. To select each pair of directories for synchronization, 
simply click on the directory folder icon you desire for the hard disk drive and removable disk drive.

 
When you have selected a directory on each drive to match, click Next.    The Setup screen will now 
appear.
 
 



Setup Directory Settings
 
You can also control the synchronization by changing the center button settings in this screen.    You can 
use the center buttons to change the directions for synchronization or to ignore a specific directory. 
 
The center buttons are displayed between the directory windows.    After highlighting the directories, 
clicking on the center buttons allow you to change from the default settings.    The choices that you have 
for changing the default settings are as follows:
 

 Ignore
 

 Two Way Sync
 

 Sync Right
 

 Sync Left
 
Right Mouse Button
NOTE:    in the Setup and Analysis screens you can reduce the amount of mouse clicking needed to set 
the center buttons. To do this, move the mouse so the cursor is over the center button you want to change 
and press the Right Mouse Button.    A menu of available choices (Left, Right, etc.) will popup (down) 
allowing an easy choice. 

The Compress File Check Box lets you choose to compress your files and save space on your 
Removable disk:
· Check the box if you want your files compressed 

before being copied to the Removable disk
· No Check in the box means that your files are copied uncompressed.
 
 Click the Next Button and you enter the Analyze screen.



Ignore Button 

This button selection will ignore the directory and the files it contains when synchronizing.    Nothing will 
be transferred or copied.

NOTICE also that in the Analysis screen when you select a directory, the center buttons of all 
subdirectories will change to an  X  (ignore). This does not change anything. It is merely an indication that 
the button with an    X    is active, and if you click on it, its setting will then control all files within the 
directory.



Bi-Directional Arrow

This arrow setting designates that the older version of the directory and files will be replaced with the 
most current version regardless of which drive it is on.



Sync Right

This    arrow designates    a one way synchronization from left to right.    DoubleZIP will synchronize or 
analyze only the files in the left directory window that have a more current date than their counterpart in 
the right window.    Nothing will be synchronized from the right to the left. Only the contents of the 
directories in the left directory window that have a more current date will    be selected for analysis or 
synchronization.



Sync Left

This    arrow designates a one way synchronization from right to left.    DoubleZIP will synchronize or 
analyze only the files in the right directory window that have a more current date than their counterpart in 
the left window.    Nothing will be synchronized from the left to the right.    Only the contents of the 
directories in the right directory window that have a more current date will    be selected for analysis or 
synchronization.



Delete Button

The Delete button selection will remove the selected file from both drives. Be careful using this function 
because the file or directory will be non-recoverable.



See the differences before syncing
 
The Analyze screen (shown below) allows you to preview what files will be copied, and the space 
available, before you sync. You enter this screen when you click the Next Button on the Setup Screen or 
you are in the Drive Selection screen and DoubleZIP detects that a valid automatic synchronization can 
be performed. 
 
DoubleZIP will display only the files and directories that are out of sync.      This means that only files and 
directories that are either unmatched or have conflicting date and time will be displayed.    You can control 
the sync, file by file, using the Center Buttons.

 
DoubleZIP will help you understand what will be sync'd by displaying: 

    Most Recent File Version Indicator
The diamond indicator only appears when the file is on both drives and has an non-identical date and 
time.    The diamond indicator appears in the directory window on the side of the file that is the most 
current version (has the most recent date and time) of the two.    This is the version that will replace the 
older version of the file on the other side during synchronization. 

 Missing Directories or Files
    Directories or files that appear on one drive but not on the other will also be displayed.    The one 
that is on the drive will be solid (yellow on color monitors) on the drive they are on and will be ghosted 
(gray) on the drive they are not on.

    File Conflict Indicator
The triangle indicator appears in both directory windows next to the conflicting files to alert you to a file 
conflict condition (both files have been changed). 

 
Click Sync to synchronize the files in the directories that you selected.    When the synchronization is 
completed, the Sync Complete screen will appear.
 
 



Center Buttons - Analyze

DoubleZIP    initially displays the default settings. Clicking a Center button changes the action of the next 
Sync on the file or directory associated with that button. Clicking on a parent directory's button changes 
the settings for all child directories and/or files within the. Selections available are:
 

 Ignore
 

 Two Way Sync
 

 Sync Right
 

 Sync Left

    Delete

 
 
The Move button appears if there is a file conflict  .   This setting will move each version to a Conflict 
Directory on the opposite drive.
 
The Rename button is used to resolve a conflict. It allows you to rename a file that is in conflict.

When no selection is needed the program blanks the button.



Compressing your files to save space
 
You can store more data on a removable disk by compressing your files.

If you want to store more data on your Removable disk, then compressing your files is the answer.    With 
compression, you can store up to two or more times the data on your Removable disk.    This increased 
storage factor will vary depending on the number and types of files being compressed and stored. You 
can also store compressed files on your fixed disk.

Compressing your data takes more time, but if you must store more, it is worth it.

It will take DoubleZIP more time to analyze and synchronize your data in compressed form.    This is 
because DoubleZIP needs additional time to compress and manage your files as they are synchronized 
to and from your disks.    The first time that you analyze and synchronize two directories, the process will 
work slower.    The next time you analyze and synchronize the same directories, the process will complete 
in less time.

Compressing your files using DoubleZIP.
 
You need to tell DoubleZIP to compress your files.    You do this in the Setup and Save Setup screens.  
The Compress File Check Box    lets you choose to compress your files and save space on disks that you 
choose to store compressed files on.
 
How do I get DoubleZIP to do this compression for me?
 
If this is a manual sync:

When you check the Compress File Check Box,    in the Setup screen, and click on the Next button, 
DoubleZIP does the following:
1.    A Compress Options dialog box appears.    You can choose to Compress to the Left Drive, to the Right 
Drive, or to Both Drives.    You can click OK or Cancel.
2.    DoubleZIP then compares the files in your selected directories on your left disk to those on your right 
disk.    You are shown the results in the Analyze screen.
3.    Next when you click on the Sync button, DoubleZIP synchronizes your files and stores these files    on 
your drives.    When the compression option is turned on, DoubleZIP copies the files in compressed form 
to the drives that were selected in the Compress Options dialog box.
 
If this is an automatic sync:

1.    First DoubleZIP searches your hard disk for an AutoSync file.    If it finds an AutoSync file, DoubleZIP 
determines if the Compress File Check Box    was checked.    If it was checked,    then DoubleZIP 
determines the selections that were made in the Compress Options dialog box.      These selections could 
be Compress to the Left Drive, to the Right Drive, or to Both Drives.    DoubleZIP displays the AutoSync 
screen.
2.    You choose the desired AutoSync and click Run.    DoubleZIP then compares the files on your left disk 
to those on your right disk as specified in your stored directory selection.    You are shown the results in 
the Analyze screen.
3.    Next when you click on the Sync button, DoubleZIP synchronizes your files and stores these files    on 
your drives.    When the compression option is turned on, DoubleZIP copies the files in compressed form 
to the drives that were selected in the Compress Options dialog box.
 
What do the compressed files look like on a disk?
 
When you view your disk from Windows File Manager or Explorer, you will see that the selected 
directories containing your compressed files have a unique extension.    This three character extension ( i. 
e. .^xx ) has been assigned by DoubleZIP so the program can quickly identify which files are compressed 



DoubleZIP files.    WARNING:    Do not rename a file that has been compressed by DoubleZIP or by the 
Compress/UnCompress utility.
 
How can I UnCompress the files on a disk?
 
If you remove the check from the Compress File Check Box, DoubleZIP will UnCompress the files 
automatically when you synchronize and store the files in UnCompressed (normal) form on your disks. 
When the compression option is turned off, DoubleZIP will not compress any files being copied.    If files 
were compressed by a previous synchronization (with the compression turned on) and they are updated 
during a later synchronization that has the compression turned off, they will be automatically 
uncompressed. 
 
Also a separate utility is provided with your DoubleZIP software that can be used to Compress or 
UnCompress files.    To launch this utility, go to the Double ZIP program group and double click on the 
Compress/UnCompress icon. 

Synchronizing files with Windows 95 Long File Names

If you are synchronizing files with long file names, then you must use DoubleZIP for Windows95.    
However, if all files being synchronized have the DOS standard 8.3 file format, then they can be 
synchronized using either DoubleZIP for Windows 3.1 or DoubleZIP for Windows95.

This also means that files with long file names that have been compressed and stored on a disk using 
DoubleZIP for Windows95 can not be synchronized by DoubleZIP for Windows 3.1.    You must use 
DoubleZIP for Windows95 to synchronize these files.

It is recommended that you use DOS’s standard 8.3 file format on all of your PCs so long as you are 
using a mix of PCs running Windows 3.1 and Windows95.    This is because the long file name 
information is not recognized by standard 8.3 file systems, and during normal file operations the long file 
names may be destroyed.    When all of your PCs are running Windows95 or NT, then long file names can 
be used. 

Other things to remember when using the Compress File option

You can choose to have DoubleZIP compress your files when they are stored on your disks.    When you 
do this please keep the following facts in mind.

1.    You will get the best performance from DoubleZIP if the files on your Removable disk are either all 
compressed or all uncompressed.

2.    Different types of files will be compressed by different factors.    On average we say that DoubleZIP 
will double the amount of data that you can store on a disk.    However, this could be more or less 
depending on the mix and size of the file types being compressed.

3.    If a disk contains compressed files and you choose to uncompress them, there must be sufficient 
space available to hold the resulting uncompressed files.    As a rule of thumb, there should be at least 
three times the amount of space available on the    disk as was required to hold the files in compressed 
form. 

4.    A Compress/UnCompress utility comes with DoubleZIP.    You can copy this utility to your Removable 
disk, and take it with you, in case you want to uncompress your files on a PC that does not have a copy of 
DoubleZIP. 

5.    You can also use PKunzip to uncompress your files, but you can not use PKzip to compress these 
files. 



6.    In a small percentage of synchronizations, a particular file may not be compressed.    This is due to 
the fact that another file in the same directory uses the same compressed file name.
 



Compress File Check Box

· Check the box if you want your files compressed 
before being copied to the REMOVABLE disk

· No Check in the box means that your files are copied uncompressed.



Progress during sync
 
DoubleZIP shows you the progress of your synchronization in the screen below:

  
 Clink on the Cancel Button if you want to cancel the synchronization.    This brings up the Drive Selection 
screen and you can begin the process again.    When the synchronization is completed, the Sync 
Complete screen will appear.
 
 



Sync Complete
 
When your sync is complete, the Sync Complete screen will appear.    It displays a Sync Complete 
message.
 
The buttons on the screen will allow you to:

New Sync

View Report 

Save Sync

Exit

 
 



Upgrade Button

Gives you information on how to upgrade to a more powerful 
version of this software program 



Sync New Button

Lets you set up and do another synchronization, backup or restore.



View Report Button

Brings up the Activity Log where you can see the detailed 
results of your analysis, synchronization, backup and restore.



Exit

If you are finished, click here.



Save Sync Disabled

This button is disabled since your backup script was automatically saved.



Save Sync

Allows you to save the sync and perform it automatically next time.
Brings up the Save Setup screen (refer to Setting Up and Saving AutoSyncs ) 



Setting Up and Saving AutoSyncs
 
DoubleZIP allows you to setup and save automatic syncs.    You can do this by clicking on the Save Sync  
button in the Sync Complete screen.    This brings up a Save Setup screen.

 
The upper portion of this screen (not shown) allows you to verify the selected directories and to change 
their settings.    The lower portion, shown above, allows you to enter an    AutoSync Description.    If you 
are syncing to a Removable disk, you will be asked to enter a unique name for the computer that you are 
using.    These AutoSync files are then stored    when you click the Save button.    Saved    AutoSyncs can 
then be selected and run without having to set them up again.
 
 
 
 
 



Selecting and Running AutoSyncs
 
DoubleZIP can save you time by performing automatic syncs.    Each time that the Drive Selection screen 
appears, DoubleZIP will detect the presence of a of one or more AutoSync files on your hard disk.    If 
AutoSync files are present on the hard disk, the AutoSync button is active.    If you click this button, you 
can select the desired AutoSync from a list. 

 

Once selected, you click the Run button and the Analyze screen appears showing the synchronization 
that will take place.    These AutoSync files are setup from the Save Setup screen.
  
 



On-Line Help
 
DoubleZIP’s on-line help is your main reference for operation of the program. The help file for DoubleZIP 
is a standard Windows help file.    You can open the help by clicking on the Help button or by pressing the 
F1 key.

On-line help will display its contents so you may select the topic of interest.    You can also search for that 
topic by entering key words. You can quickly find topics by using this feature.

How to use on-line help

On-line help will display its contents so you may select the topic of interest.    You can also search for that 
topic by entering key words.    Once a topic appears in the help screen, you will notice that there are 
Jumps and Pop-ups. 
 
A jump is shown in green with solid underline.    Clicking on this Jump will take you to another topic 
related to the one you are viewing.
 
Pop-Ups are shown in green with a dotted underline.    Clicking on a Pop-up will bring up a text box with 
related information or definitions on top of the help topic related to the one that you are viewing.
 
Search Help on...
 
On-line Help lets you search for a topic using a keyword search under the Search for Help on.... 
command in the Help menu.    You can quickly find topics by using this feature.
 
The About Screen
 
In the Help menu select "About DoubleZIP".    Information about DoubleZIP is displayed including: 
program version, Copyright details, and licensee identification.
 
Readme File
 
Your DoubleZIP program group includes a Readme.txt file.    This file contains information about this 
version of DoubleZIP, along with descriptions of last-minute additions or changes to the product.    You 
should read this file before using this version of DoubleZIP.
 
 



Technical Support
 
Online Information

The latest information about updates and enhancements to DoubleZIP, along with news about other 
products and special offers can be found by accessing the Kiss web page at http://www.kissco.com.

 
Automatic Updates

To make sure you have the latest version, be sure to use the automatic update feature. As soon as we 
add a feature or fix a bug, it will appear here for you to automatically download. See the Automatic 
Update section of the Using DoubleZIP chapter for more information.

Technical Support

Free technical support is provided to all users for the first sixty (60) days following installation by calling 1-
503-598-8710 from 6am to 6pm Pacific Time, Monday through Friday, except major holidays. Technical 
support is also available by accessing the Kiss web site or emailing a question to support@kissco.com. 

Following the first 60 days, technical support is available for a small fee.

When contacting technical support, you need to identify your product by the serial number that was 
included with the software when it was purchased. To save time, please locate your serial number before 
contacting technical support.

 



Menu Functions

DoubleZIP is controlled through pull-down menus in the menu bar - as well as the Tool Bar and Command 
Buttons discussed elsewhere. Menu choices are:

File Menu
Create Directory 
Refresh 
Exit 

Tree Menu
Expand One Level 
Expand Branch 
Collapse Branch 
Indicate Expandable Branches 

View Menu
Show Date 
Show Date and Time 
Show Size 
Sort by Name 
Sort by Date 
Activity Log 
Match History 

Options Menu
Confirmations 
Filter Options 
Set Conflict Dir name 
Save Settings

Help Menu
Check for Software Updates
Rollback Software Updates
Kiss Technical Support
Kiss Web Page



Create Directory
  
Enabled only in the Directory Selection screen, this function allows you to create a new directory (as a 
child to the one selected in the Directory) while in DoubleZIP. When this is chosen, with a directory 
selected in a Directory Window, the dialog box    will appear.

The checked radio button indicates which directory is selected.      Enter the name for the new directory in 
the space provided and click on OK.



Refresh

Causes DoubleZIP to reread the selected drives and display the results.

When changes are made to the file system with other applications, DoubleZIP does not reflect the 
changes until you refresh the drive by re-selecting the drive in the drive list box - or select Refresh from 
the File menu item.

When changes are made to files while DoubleZIP is running, we recommend you use Refresh to update 
the contents of both directory trees.



Expand One Level

Expands the selected directory by one level in the tree display .



Expand Branch

Expands the entire branch under the selected directory in the tree display.



Collapse Branch

Collapses the entire branch under the selected directory in the tree display.



Indicate Expandable Branches

Toggles On and Off indicators showing whether a directory can/cannot be further expanded.



Show Date
 
Enabled only on the Analyze screen. Shows date file was last modified. This date appears in the Directory 
Window next to the file folder.

NOTE: Only one option - Show Date, Show Date and Time, Show Size - operates at a time.



Show Date and Time 

Enabled only on the Analyze screen. Shows date and time file was last modified. Date and time appear in 
the Directory Window next to the file folder.

NOTE: Only one option - Show Date, Show Date and Time, Show Size - operates at a time.



Show Size

Enabled only on the Analyze screen. Shows size of file in bytes.

NOTE: Only one option - Show Date, Show Date and Time, Show Size - operates at a time.



Sort By Name

Enabled only on the Analyze screen. This option sorts and displays the files in the Directory Windows 
alphabetically. 



Sort By Date

Enabled only on the Analyze screen. This option sorts and displays the files in the Directory Windows by 
date. 

Directories are shown alphabetically



Confirmations 

Please realize that, by the nature of the synchronization process, files will be replaced with more current 
versions. The older version of files will not be recoverable except from back-up media which you are 
responsible for making.

Enabling and Disabling Confirmations 
You can enable or disable (show or hide) Confirmation messages by selecting Confirmations under the 
Options menu on the menu bar.

The Confirmation messages can be independently enabled or disabled by clicking on the box next to 
each. An X enables the message; a blank box disables it. We suggest leaving them activated, at least at 
first, as a precaution. 

Replace or Delete
DoubleZIP will warn you before it synchronizes a file if the action will replace or delete data. You will be 
asked to OK this. The message - shown on Page 14 - appears:

To confirm that you want to proceed, click on OK. To abort the synchronization process and return to the 
previous screen, click Cancel.

A second message will appear before DoubleZIP replaces or deletes a file. This warning will provide 
information on what files will be replaced or deleted. 

To continue, click on Yes for the individual file or Yes to all for everything. 
To abort the process, click No.
To abort the process identified and return to the previous screen click Stop.



Set Conflict Dir Name

You can name the Conflict File Directory by accessing Options on the menu bar.

Type in the name you want for the Conflict Directory (it's preset to "conflict") and click OK. 



Filter Options

Allows you to show or hide files with specific file extensions, or to show only files found on both drives 
with different dates. When you select Filters the dialog box appears.

To show or hide files with a specific file extension, type the three character extension in the name box and 
click in the appropriate box (Show or Hide).

To Analyze or Sync only files found on both drives, and prevent showing or syncing missing files, click in 
the lower box placing an X there.

When finished, click OK.



Save Settings

Allows you to save the currently selected options and dialog message settings. These are: 
 

Confirmations
 
These options will be saved, remaining in effect when the program is next run.
 



Activity Log

Selecting Activity Log displays it. The Activity Log provides the status and sequence of all analyses and 
syncs performed. This log will indicate files sync'd, warning messages, conflicts and errors that took place 
during synchronization.



Sync History

The Sync History Log    shows the directory-pairs of previous synchronizations. The history list is in 
chronological order, the most recent sync at the bottom.

The buttons at the bottom of the Sync History window give you these choices:

Cancel and return to the previous screen,
Done activates changes made and returns to the previous screen; 
Delete allows you to delete lines from the History Log. 

(NOTE: DoubleZIP uses this Log to check for file conflicts. If you delete a Sync History line item, 
DoubleZIP won't report a time conflict, if it exists, the next time you sync those line items.)



Check for Software Updates

From time to time Kiss Software will make minor revisions and enhancements to DoubleZIP. To check if 
there is a newer version, simply click on the "Check for Software Updates" command in the Help menu.    
Your program will be automatically updated ( or you will be told that no updates exist at this time ).



Rollback Software Updates

After performing a Software update using the "Check for Software Updates" menu item, you may go back 
to the previous version of DoubleZIP by using the "Rollback Software Updates" command in the Help 
menu. This feature is provided to effect a recovery to your previously operating DoubleZIP program.



Kiss Technical Support

If you can connect to the Internet, you can automatically dial, activate your Web Browser and view Kiss 
Software's Tech Support page on their Web Site by clicking on this Help menu item.



Kiss Web Page

If you can connect to the Internet, you can automatically dial, activate your Web Browser and view Kiss 
Software's Web Site by clicking on the Help Menu and then on the Kiss Web Page item.



If you are Synchronizing your files

QuickStart continued:

 5      Select the directories
A. Select the two directories containing the files you wish to synchronize, one in each directory 
window. 
B. To select a directory, click on the directory folder and highlight it.    When two are selected, Click 
Next.

 
6      Setup the directories 

A.    You can select subdirectories and the direction of synchronization here.
B.    For simple updates just click Next.

 
7      Perform an Analysis

A.    The Analysis screen displays all the files that are out of synchronization in the directories you 
selected.    It shows you the files to be copied and the direction of the copy.provides you with 
information on your files and allows you to control the synchronization process.
B.    Click on Sync to proceed with the synchronization. To change your selections click Back.

 
8      Synchronize your files

A.    DoubleZIP will perform a synchronization, putting the most current version of the files on both 
disks.    Missing files will be copied over, making the selected directories a mirror image of each other. 
B.    A Synchronization Completed dialog box will appear after the sync has completed. Click on Sync 
More    to perform another synchronization.
C.    Click Exit to quit.
D.    Click Sync automatically next time to setup a automatic synchronization (Refer to Syncing 
Automatically). 

 



If you are Backing-up your files

QuickStart continued:

5      Create Backup
A.    Click Create New    in the Select Backup screen. 
  

6    Enter Description 
A.    Enter the text description of this backup on the Create New Backup dialog and click OK.

 
7    Select the directories

A.    Select the directories on your hard disk containing the files you wish to backup. 
B.    To select a directory, click on the directory folder icon you desire to backup.    The directory will 
then be highlighted.
C.    Make sure all files to be backed-up are closed before proceeding.    Then click Next.

 
8    Setup the directories

A.    You can select subdirectories here.    Refer to on-line help.
B.    For simple updates just click Next.

9. Backup or Restore your files
A.    DoubleZIP will copy the directories and files on your hard disk to your removable disk.    All existing 
files will be overwritten, creating a mirror image of the hard disk directory on your removable disk. 
B.    When the backup is completed, click on New Sync to do another sync, backup or restore.    Click 
Exit to quit. 

 



Troubleshooting

Thank you for using DoubleZIP. If you have troubles or problems, check the online FAQs (Frequently 
Asked Questions) at http://www.kissco.com/faqs/dz_faq.htm or email to tech support at 
support@kissco.com. However, before you do that, check out the following common problems, with their 
explanations and solutions.

Check Your Results

DoubleZIP provides two ways to easily check the results of a Sync or Backup/Restore operation.    First, 
you can analyze the selected directories performing a manual sync.    The Analyze screen will show you 
the differences between the two selections.    Second, you can view the results of the operation in the 
Activity log.    To view this log, click on Activity Log in the View menu.

Common Reason for Errors

Disks that are either not available, not loaded or out-of-space are a common cause of errors.    To check 
for the out-of-space condition, use the Analyze screen to display Space Available on each disk.

Selecting Directories for Synchronization

Remember when you click on a directory to highlight it, this selects it and all subdirectories and files within 
it.    This tells DoubleZIP that when you click on the center button associated with that directory you want 
the center button’s setting to apply to all the subdirectories and files within the selected directory. If    the 
directory is not highlighted, then any activity control button changes you make apply only to the files 
within it.

Working with Compressed Files

DoubleZIP can automatically compress the data that it stores on your Removable Zip disk.    When you 
view your Removable Zip disk from Windows File Manager or Explorer, you will see the selected 
directories containing your files with an .^xx extension.    If for some reason, you need to work with that 
file, you can uncompress it using either the DoubleZIP Compress/Uncompress utility or a PKZIP 
compatible compression utility.    You should again compress the file immediately upon completing your 
task so that it will properly be included in Sync and Backup-Restore operations performed by DoubleZIP.

Syncing Long File Names

If you are synchronizing files with long file names, then you must use DoubleZIP for Windows 95.    
However, if all files being synchronized have the DOS standard 8.3 file format, then they can be 
synchronized using either DoubleZIP for Windows 3.1 or DoubleZIP for Windows 95.    This also means 
that files with long file names that have been compressed and stored on a removable disk using 
DoubleZIP for Windows 95 can not be synchronized by DoubleZIP for Windows 3.1.    You must use 
DoubleZIP for Windows 95 to synchronize these files.





Using DoubleZIP to Backup or Restore Files
 
DoubleZIP is designed to guide you through a simple process of easily backing-up your files to one or 
more removable disks.    You simply load the required removable Zip disk in its drive and run DoubleZIP.    
With the click of a button, DoubleZIP helps you to: (1) Create a New Backup Disk Set, (2) Restore from 
an existing Backup Disk Set, or (3) Re-do Backups automatically.    DoubleZIP lets you choose to backup 
your files in either compressed or un-compressed form.    If the backup or restore requires more than one 
removable disk, the program will prompt you to load the next disk until the process completed.    The 
resulting disks are called a Backup Disk Set.    DoubleZIP then saves the definition of this backup so you 
can run it automatically next time.    Remember to clearly label and store your Backup Disk Sets in a safe 
place. 

For detailed descriptions of the steps that DoubleZIP takes you through, select from the topics below.

Drive Selection for Backup 

Select Backup

Create New Backup

Directory Selection

Setup Directory Settings 

Backup/Restore Complete

Selecting and Running an AutoBackup/Restore

Handling File Compression with Backup/Restore

Creating and Using Backup Disk Sets



Drive Selection for Backup

When you start DoubleZIP, the Drive Selection screen will appear.    This screen allows you to select 
which disk drives are going to be backed-up or restored.    You now select a removable drive, in the lower 
drive list box, and load it with the required removable disk.    When this has been done, you click the Multi 
Disk button, DoubleZIP then displays the Select Backup screen (following page) where you can either 
Create a New Backup or Restore from or Re-do Backups automatically.

 
To display the available drives, click on the down arrow in the Drive Selection Box. Click on the drive you 
wish to select for Backup or Restore in each Drive Selection Box.



Select Backup

The Select Backup screen appears when the Multi button in the Drive Selection screen is clicked.    This 
screen allows you to: (1) Create a New Backup Disk Set, (2) Restore from an existing Backup Disk Set, or 
(3) Re-do Backups automatically.
 
Backup

Restore

Create New

Delete

Refresh List

Cancel



Create New Backup

When you click Create New in the Select Backup screen the Create New Backup dialog appears.    Enter 
a description of the backup and click OK.



Directory Selection for Backup

You can now select the directory on your hard disk that you want to backup to your removable disk.    
WARNING: All files to be backed-up should be closed before proceeding. To select the directory to 
backup, simply click on the directory folder icon.

 
The Compress File Check Box can either be checked or not checked, since all files backed-up to the 
removable disk can be stored in either compressed or un-compressed form.



Setup Directory Settings for Backup

This screen allows you to further control the backup by changing the center button settings in this screen. 
You can use the center buttons to ignore specific sub-directories.    With the click of the Next button, your 
selection will be backed-up to your removable disk.    If the backup requires more than one removable 
disk, the program will prompt you to load the next disk until the backup is complete.    When complete, the 
definition of this backup will be saved to run automatically next time.

The center buttons are displayed between the directory windows.    Clicking on the center buttons allows 
you to change the settings.    The selections that you have for changing the settings are as follows:

 This button selection will ignore the directory and the files it contains when backing-up or 
restoring.    Nothing will be transferred or copied.

 This arrow designates    a backup from your hard disk to your removable disk.

The Compress File Check Box can either be checked or not checked, since all files backed-up to the 
removable disk can be stored in either compressed or un-compressed form.



Backup/Restore Complete

When your sync is complete, the Sync Complete screen will appear.    It displays a Backup Complete 
message.    Now you can do another backup, restore, manual sync, or exit the program.
 
The buttons on the screen will allow you to:

New Sync

View Report 
Exit

 



Selecting and Running an AutoBackup/Restore

DoubleZIP can save you time by performing automatic backups and restores.    Each time that the Multi 
Disk button is clicked in the Drive Selection screen, DoubleZIP will detect the presence of one or more 
AutoBackup files.    If AutoBackup files are present, they will be listed in the Select Auto Backup screen.    
You can select the desired AutoBackup from a list.    Once selected, you click the Backup or Restore 
button and backup or restore will take place.    These AutoBackup files were saved automatically by 
DoubleZIP when you created a New Backup.    If no AutoBackups appear on the list you can create one 
by first clicking the Create New button.

 
Backup Description

Backup Button

Restore Button

Create New Button

Delete Button

Refresh List Button

Cancel Button



Handling File Compression with Backup and Restore

Backing-up compressed and compressed Files
When you Backup files, they will be stored on your Backup Disk Set in compressed or uncompressed 
form according to the Compress/Uncompress option setting.

Restoring compressed and uncompressed Files
When you restore files from your Backup Disk Set, they will be restored to their original compressed or 
uncompressed form which existed on your fixed disk at the time of the backup.    This is the case except 
when backing-up compressed files on your fixed disk and the compression option is checked on.    In this 
case, the files will be restored as uncompressed files on your fixed disk.



Creating and Using Backup Disk Sets

Creating New Backup Disk Sets
When you create a New Backup Disk Set it is good practice to label each disk in the set with:

o    The AutoBackup description

o    The sequence number of each disk in the Backup Disk Set ( i.e. disk # 1, 2, 3 etc. in the set )

o    The Backup Disk Set number ( if you keep more than one Backup Disk Set for particular AutoBackup).

o    The Last Disk Identifier ( i.e. disk 3 of 3 )

Backing up over Backup Disk Sets
Before you can backup over an existing Backup Disk Set, the previous backup data must be deleted.

Restoring from Backup Disk Sets
Before you begin the restore of an existing Backup Disk Set, insert the last disk into the removable drive. 
It is good practice (but not required) to insert the remaining disks in sequence according to their number.

Organizing Backup Disk Sets
It is considered good practice to maintain at least two Backup Disk Sets of important data.    These 
Backup Disk Sets can be labeled A, B, etc. for example.

Reusing Backup Disk Sets
If you want to use a disk that was a member of a Backup Disk Set that is no longer needed, use the 
Windows Explorer to delete the data on the disk before using it for other purposes.



Backup Button

To Re-do Backups automatically, select an AutoBackup description from the list and click the Backup 
button.    If the disk not loaded in the removable drive you will be prompted to load it.    DoubleZIP will then 
display the Setup Directories screen showing the directory settings for this backup.



Restore Button

To Restore from an existing Backup Disk Set, select an AutoBackup description from the list and click the 
Restore button.    If the last disk in the Backup Disk Set is not loaded in the removable drive you will be 
prompted to load it.    DoubleZIP will then display the Setup Directories screen showing the directory 
settings for this restore.



Create New Button

If this is a new backup, click the Create New button.    DoubleZIP will then display the Create New Backup 
and Directory Selection screens where you name your backup and select specific directories Pairs on the 
hard disk to be backed-up to the removable disk.



Delete Backup Button

To delete a stored auto-backup script, click the Delete button.    Note that only the stored backup script 
will be deleted from your fixed and removable disks.    The next time you try to backup to the disks in this 
set DoubleZIP will ask you if you want to delete the backup data that is on the disk.



Refresh List

Click the Refresh button to insure that the displayed list of backups is up-to-date.



Cancel Backup/Restore

Click the Cancel to return to the Drive Selection screen.



Description

The AutoBackup description of the stored auto-backup(s) is displayed in the Select Backup screen's text 
box.




